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Introduction 
The Creator program is made by Applied Streetview. 
It processes streetview footage recorded by the Applied Streetview Camera.  
 
 
Output 
- A folder with leveled, geo-referenced, equirectangular streetviews.  
  The streetview picture size is 8192 x 4096 pixels. 
- A krpano-based player for the internet or your company's intranet. 
- Data for the optional Android Player, which works 100% offline. 
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Installation 
First download and install the CUDA 8.0 drivers. 
Do not use CUDA 9. 
https://developer.nvidia.com/cuda-80-ga2-download-archive 
 
Then download and install the newest Creator program: 
http://applied-streetview.com/project/creator/ 
 

Speed it up 

Virus Scanners 
Deactivate any 3rd-party Virus-Scanner you might have installed.  
Deactivate for ​Creator​, all folders it uses (including ​in​ and ​out​) and the​ .jpg​ file format. 
 
Windows Defender 
Exclude the Creator ​installation folder​: 
C:\Program Files (x86)\Creator 2 
 
Also ​in ​and ​out ​folders for the data: 
F:\in 
F:\out 
 
And the ​temporary data​ folder: 
C:\Users\USERNAME\AppData\Local\creator2\tmp 
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Exclude .jpg files and the Creator programs: 
 

 

Additional Manuals 
Additional manuals are available at our website: 
http://www.applied-streetview.com/ 
 

HOW-TO video 
Shown automatically when you first open Creator, and later can be found in ​Help -> Demo 
Video 
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Licensing 
Creator will work for 21 days as a trial with all the features available.  
There are no limitations at all. 

 
 
When starting Creator for the first time, the ​Register ​popup will be displayed.  
Fill it in and click the ​Register ​button. 
 
Permanent activation key 
With the purchase of a camera you will get a permanent activation key for Creator.  
In the menu click ​Help -> Add activation key​. 
Paste in the activation key and click the ​Register ​button.  
Additional activation keys are available. ​Contact us. 
 
Offline registration 
If the PC you would like to use for Creator has no internet connection, instead of the Register 
button you will see a ​Register Offline​ button. 
Click on the Register Offline button and follow the on-screen instructions. 
 
 
Menu - Help - License Details 
Shows the type of the licence and the end of the trial period. 
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Evaluation Licence: 

 
 
Paid licence: 
A purchased Creator licence never expires. 
 
 
Menu - Help - Add activation key 
Opens the license Register popup. Use this to update your evaluation license to a purchased 
license or replace a license. 
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User Interface 

Language 

English, French, Spanish, German, Arabic, Russian, Chinese, Romanian and Czech are 
available. 
 

Interface 

Standard 
Everything it needs to process a project. 
 
Advanced 
For more complex projects and experienced users. 
 
Menu entries for Advanced Features have a ​bold font​. 
 

Main Window 
Tools 

 
Menu 
Timeline 
Separate by Distance 
Individual Optimizing 

 
Preferences 
For all projects -> Expert Mode 
For all projects -> Troubleshooting 
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Themes 

Dark 

 
 
Light 
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Recommended Operating System 
Windows 7, 8 or 10. 
64-bit, any language. 
 
32-bit Windows is not supported and will not work. 
 

Recommended Hardware 
Minimum requirements: 
 
A must-have for production: 
NVIDIA GTX 1080 graphics card with 8GB VRAM. 
 
With the NVIDIA GTX 1080 graphics card, about 75.000 datasets can be processed every 24 
hours. 
 
Other components: 
CPU with 4 cores and 8 threads, minimum 3.4 GHz. 
16 GB RAM 
250 GB SSD, or larger. For the Windows operating system. 
2TB HDD for small data-sets.  
Network drives (NAS) are recommended for larger data-sets. 
 
Testing 
You can try Creator with any 64-bit Windows 7, 8 or 10 PC. 
However, without an NVIDIA graphics card and at least 8GB PC RAM processing will be 
extremely slow. 
 
Example Data 
Download and unzip the Example Data footage to process it: 
http://aplsv.s3.amazonaws.com/Demo2/Demo2.zip 
 
Check out the Creator Video, Manual and Quick Starter Guide: 
http://applied-streetview.com/project/creator/  
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Projects & Tours 
What is a Project? 
To do any recording you first need to enter a ​Project ​name into the camera's Remote Control. 
The Remote Control creates a ​Project folder ​on the SSD. 
 
What is a tour? 
When you press the​ Start​ button on the camera's Remote Control a new  
Tour folder​ is created as a subfolder of the ​Project folder​.  
 
Here you see the ​Example-Data​ Project folder. 
It has three Tour folders.  
The screenshot shows Tour folder ​camera-20170705-172306​. 
Each Tour folder then has 7 sub-folders: 
1 to 6​ for the images and ​7​ for the log data. 
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Folder Structure 
The Creator needs the following Folder Structure on the processing PC to work: 
 
Create an empty ​in ​and ​out ​folder. ​Work​ is just an example parent folder, this could be any 
folder on any drive or NAS. 

 

 
Do not process directly from the SDD. Always copy the data to a PC first. Disconnect 
the SSD before starting processing. It will act as your backup copy.  
Make a backup copy of the recorded data for safekeeping. 
 
Copy the Project folder from the ​cameras SSD ​to the ​in ​folder. 

 

 
Creator saves its output to the ​out ​folder.  
It automatically creates the Project name (Example-Data) in the out folder. 
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You can have the ​in ​and ​out ​folder on the same HDD or SSD. 
Or on different drives. 
Or on network drives. 
Or mixed. 
 
The ​out​ folder should be a local drive for speed reasons. 
 
You need to set the ​in ​and ​out ​folders in Creator. 
Creator will ask you for the folders when necessary. 
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Workflow 
Just work through the tabs from left to right: 

 
 
Of course, at any time you can go back to a previous tab and apply changes. 
 
To enable additional tabs go to ​Menu ​- ​Interface ​and click ​Advanced​.  
Advanced tabs appear in bold. 
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Project Management 

Projects list 

 
 
The Projects list 
For each project you see: 
- Number of tours 
- Number of streetviews 
- Number of timelines 
 
New project​ button 
Open a project folder with at least one tour folder to add. 
You can select and deselect tours in the pop-up. 
 
Restore from a backup file​ button 
Restore a project from a backed-up file. 
 
Backup all projects 
Backup ​all​ projects. The source photos are ​not included​ in the backup. 
 
Open ​button 
Open the project. 
 
Backup​ button 
Backup the project. The source photos are ​not included​ in the backup. 
Delete​ button 
Delete the project from the Creator program. The source photos are ​not deleted​. 
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Date modified 
The date of the last edit made to the project. 
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Project 

 
Tours list 

 
 
Edit project name 
Change the project name. 
 
Change project input path 
Change the project input path, if a project has been moved. 
 
Delete project 
Delete the project from the Creator program. 
The source photos will not be ​not ​deleted. 
 
Close project 
To open another project or shut down the Creator program. 
 
Tour name 
Click a tour name to open it on the Map. The map will zoom in on the tour. 
Good to find a tour quickly on the map. 
 
 
Tour folder 
Where the source-data is. 
Edit​ icon​: ​The path to a tour folder can be changed individually. 
 
Timeline 
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Timeline title. This column is visible only if a timeline has been assigned to a tour in the 
Timeline tab. 
 
Streetviews 
Number of recorded data-sets. 
 
Active 
Number of active streetviews.  
 
Deactivated 
Number of deactivated streetviews. On the map tab you can deactivate streetviews to not 
process them, for example when a road has been recorded twice. 
 
Yaw, Pitch, Roll 
Settings from the Leveling tab. 
 
Exposure 
Setting from the Leveling tab. 
 
Timezone adjustment 
Unnecessary if the ​Tablet is set to the local time​. 
Manually adjust the GPS date and time by the time zone value to fix the local (recording) date 
and time. 
 
Recording mode 
Mode used when recording the streetviews. Either Interval, Distance or Manual. 
 
Move​ button 
Move the tour to a different project. 
 
Copy​ button 
Copy the tour to a different project. 
 
Delete​ button 
Deletes the tour from the project. 
The source photos are ​not ​deleted. 
 
Backup​ button 
Backup the tour. 
The source photos will not be ​not ​backed up. 
 
Move All ​button 
Moves all tours to a different project. 
 
Copy All​ button 
Copies all tours to a different project. 
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Add tours or project​ button 
Add one or multiple tour folders to this project. 
E.g. when additional roads have been recorded three months later. 
 
Import tour from backup file​ button 
Add a tour from any tours backup file 
 
Import tours from a project backup files​ button 
Add one or more tours from any project’s backup file. 
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Map 

Right click​ on the Map for the menu: 
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Maps 
The Screenshot shows the​ OpenStreetMap.Mapnik​ map. 
Select any online map provider from the dropdown list, or use your own custom set of 
map-tiles. 
 
To select your own custom map-tiles click on the first item in the list:  
Your Company's map tiles​. This opens the ​Custom map tiles​ popup.  
Label​, ​Url ​and ​Attribution ​properties can be adjusted in this popup.  
The Url can point to either an online resource like: 
http://www.your-company.com/map-tiles/{z}/{x}/{y}.png  
 
or a local folder or NAS drive: 
file://D:\folder\{z}\{x}\{y}.png 
 
where {z} is the zoom level, and {x} and {y} are the coordinates of the top left corner of the tile 
in web mercator projection.  
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Main Map menu 
Right-click ​on the map to access it.  
Move the mouse outside the menu to close it. 
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Display 

 
 Icons       Lines   Both 

 
 

 
 
 

 
 

 

 
Show or hide active and deactivated streetview icons. 
 
Usually more footage than needed is recorded. 
Using the ​Duplicate Remover​, ​Separate by Distance​ ​(Interface -> Advanced), as well as 
manual deactivation on the map tab this can be reduced. 
 
The Map tab is where you can check which streetviews are left active for processing. 
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Deactivated streetviews are shown in a 
different color. 
 
For this tour it is dark blue. 

 
Info-Pop-Up 

 
See the data for that streetview. See the default selection in the image below. 
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Configure​ button 
Customize what data to display using the pop-up 
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Toggle Lines 

 
When displaying streetviews as lines, do not draw a line between streetviews if distance 
between them is more than the set ​Distance. 

POI 

 
Display ​Points Of Interest​ recorded using the POI tab in Remote Control. Black circles 
around a streetview icon indicate that it’s a POI. A label with the POI name is displayed to the 
right of the streetview icon. 
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Show POI left panel top section (​Filter By​): 
In this list all unique POI names are displayed. By default all POI are activated. Click on a POI 
name to deactivate it. Click again to activate. Multiple POI names can be deactivated at the 
same time. 
 
Show POI left panel bottom section (​POI list​): 
Click on a POI name to zoom into it on the map. The selected POI will have a red outline. If 
the POI was recorded in sticky mode, only 1 entry will be displayed in the list with the ability to 
zoom into the first and last streetviews of the sticky sequence by clicking on the ​First ​and 
Last ​buttons. 
 
Show all​ - Check all ​Filter by​ items. 
 
Hide all​ - Uncheck all ​Filter by​ items. 
 
Activate all POIs​ - Reset all automatically deactivated streetviews (this includes Duplicate 
Remover and Separate by Distance), 
then deactivate all streetviews and activate only the streetviews containing a POI. 
This action will not overwrite manually activated or deactivated streetviews. 
 
Reset activated POIs​ - Reset all automatically deactivated streetviews (this includes 
Duplicate Remover and Separate by Distance). 
This action will not overwrite manually activated or deactivated streetviews. 
 

Roads 

 
Show Roads assigned in the Roads tab. 
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Show all​ - Check all ​Road list​ items. 
 
Hide all​ - Uncheck all ​Road list​ items. 
 
Show Road names pop-up​ - Moving the mouse over a streetview will display thes Road 
name instead of the Info-Pop-Up. 
 

Floors 

 
Show Floors assigned in the Floors tab. 
 
Show all​ - Check all ​Floor list​ items. 
 
Hide all​ - Uncheck all ​Floor list​ items. 
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Show Floor names pop-up​ - Moving the mouse over a streetview will display the Floor name 
instead of the Info-Pop-Up. 

Tunnels 

 
Show/Hide - ​Show only streetviews which are considered a tunnel. 
 
 
Highlight - ​Highlight streetviews which are considered a tunnel. 
 
A streetview is considered in a tunnel when GPS HDOP and VDOP values are above 10 
meters, which typically only happens when the camera is inside a tunnel. 
 

Duplicate Remover 

 
Overruled by Manual activations​: Panoramas activated manually will override values set by 
the duplicate remover. 
 
Overruled by Manual deactivations:​ Panoramas deactivated manually will override values 
set by the duplicate remover. 
 

Display all the data-sets at any zoom level 

 

When viewing the map at a zoom level 20 in order to improve performance, 
not all streetviews and tracks will be shown. 
 
If you need to view the entire data-set without any optimization, click on the 
zoom level button (top left corner of the map), a warning popup will be 
displayed to warn about performance implications, then click the ​OK​ button. 

 
Undo and Redo 
Either undo or Redo the last edit action. Works on theoretically unlimited levels. 
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Keyboard Shortcuts 
 
Icons 
Key Function 
Ctrl + z Undo 
Ctrl + y Redo 
Ctrl + a Select all visible icons (even outside the map) 
Ctrl + q Deselect all visible icons (even outside the map) 
 
Delete Deactivate selected icons 
Insert Activate selected icons 
 
Home Rotate selected icons right 
End Rotate selected icons left 
 
Page-Up Next streetview 
Page-Down Previous streetview 
 
Ctrl + l Line-up selected icons. From first to last selected icon. 
 
Ctrl + R Assign a Road name to a selected Streetview(s) 
Ctrl + F Assign a Floor name to a selected Streetview(s) 
 
Map 
Key Function 
4 arrows Move map up, down, left, right. Additional you can left-click 

with the mouse, then hold and move the map. 
 
Mouse-wheelZoom in and out 
+ Zoom in 
- Zoom out 
 
Select single icon 
Click it with the mouse. 
 
Select many icons 
Select first icon with the mouse. Press and hold the ​Shift ​key.  
Select last icon with the mouse. 
 
Move one or many icons 
Select, then move with the mouse. 
  

Version 2018-05-02 Page 31 of 93 

 



Road Names 

Automatic 
To assign road names automatically using OpenStreetMap, click on ​Get Road names from 
OpenStreetMap​ button. 
 

 
 
Manually 
Click on a cell in the ​Manual​ or ​Automatic​ column to edit its content. 
 
Manually assigned Road names will always overwrite automatically assigned Road names. 
 
Map tab: 
Select one or multiple streetviews on the map.  
Click CTRL+R, enter the Road name and click ​Save​. 
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Preferred language 

● Local language only - "name" value of the OSM road. 
● Custom language - "name:language" value of the OSM road.  
● Custom language, fallback to local if not specified - If "name:language" value does not 

exist use "name". 
 
For 

● Activated streetviews 
● Deactivated streetviews 

 
Mode 

● Fill in - Only update empty values in streetviews 
● Overwrite - Overwrite all existing geocoded values in streetviews 

 
Maximum distance (m) 
Maximum Distance to the closest point on a road and a streetview to be considered for 
geocoding. 
 
Get Road names from OpenStreetMap 
 
Reset all automatically assigned values 
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Floors 

Floor names are created from ​POIs 
Click on the ​Import Floor values from POI​ button to get the Floor names. 
 
For this feature to work, you need to assign Floor names as ​POIs​ while recording., using the 
Mark point with comment​ or ​Mark line with comment​ action in the Remote Control’s ​POI 
tab.​ Set the comment as the name of the Floor.  
 

 
 
 
Manually 
Click on a cell in the ​Floor ​column to edit its content. 
 
To assign a Floor name to a streetview from the Map tab: Select one or multiple streetviews, 
click ​CTRL+F​, enter the Floor name and then ​Save​. 
 
The order of the floors is important and should follow the original layout. An example of a valid 
order would be: -1, Ground floor, 1, 2, 3, 4, 5. 
 
Click on the ​Reverse table order​ to sort the table ​upside down​. 
 
Drag and drop​ rows in the table to reorder. 
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Duplicate Remover 

Removes duplicate recordings from roads recorded more than once.. 

 
Options: 
Process selected timelines: 
(Visible only when there are timelines) 
Process only selected timelines. 
Press ​CTRL ​and then click on a timeline to select multiple timelines. 
 
Process selected tours: 
Process only tours selected from the list.  
Press ​CTRL ​and then click on a tour to select multiple tours. 
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Favor newer footage: 
Add streetviews for new roads, and replace existing streetviews.  
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Favor existing footage: 
Keep existing streetviews, add streetviews for unrecorded roads: 

 
 
Remove by radius 
Remove all streetviews within x meters of this streetview. 
 
Remove by time calculated from speed / Remove by time 
But only if the streetview to be removed is at least x seconds newer or older than this 
streetview. 
 
Remove by time calculated from speed option 
This default option gives good results for most situations, to take care of huge speed 
differences. Depending on which value is bigger it uses either the​ calculated time​ or the 
Remove by time​. 
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Remove by time 
Gives you total control for special situations. 
 
Consider Altitude 
By default the altitude is not used to determine what is or is not a duplicate. 
 
You will have to try a few times to find the optimum settings for your footage.  
These three options allow you to try again and again: 
 
Reset all streetviews 
Reset all streetviews deactivated by ​Duplicate Remover​ and ​Separate by Distance 
 

 
Check the Duplicate Remover results on the Map tab. 
 
You then can fine-tune this by manually activating or deactivating streetviews. 
 
Manual changes will be kept when running the Duplicate Remover again. 
 
By default, manual edits are set to overrule results from the Duplicate Remover. 
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Watermark 

Add watermarks to the streetview. The changes in this tab can be previewed in the ​Leveling 
tab. 
 

 
 
Add watermark 
Add watermarks to the resulting streetview. 
 
Text 
Watermark text. 
 
Font 
Watermark font name, font list is taken from C:\Windows\Fonts. 
 
Size 
Watermark text size. 
 
Opacity 
Watermark text opacity. 
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Number of watermarks horizontally 
How many watermarks to place horizontally (left-right). 
 
Number of watermarks vertically 
How many watermarks to place vertically (up-down). 
 
Add mask 
A mask will cover the car’s rooftop. 
It is a transparent PNG image overlaid on top of the streetview.  
A sample mask can be found in  
C:\Program Files (x86)\Creator\masks\example-car-roof-mask.png 
 
Mask path 
Path to the mask PNG image. Create your own mask file. 
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Leveling 

Adjust for the difference between the camera and the leveling sensor. 

 
 
In perfect world 
- the camera would be mounted 100% vertical. 
- the leveling sensor would be mounted 100% horizontal. 
- both would look exactly forward, and in the exact same direction. 
 
In the real world this does not happen. 
Because of this you need to adjust for the three angles between the camera and the sensor. 
Use the​ Pitch+​,​ Pitch-​ and​ Roll+​,​ Roll-​ buttons to adjust until the streetview looks leveled. 
Alternatively you can directly enter numerical values into the fields on the right. 
 
Check your findings with a few other streetviews of the same tour by entering a different 
name into the​ Panorama​ filed. 
 
Click the​ Save to this tour​ button to save the values to this tour only. 
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If the camera mount and the leveling device mount have not been removed from the car in 
between tours, you can use the same settings for all tours in the project. 
 
Click on ​Save to all tours of the same timeline ​button to save the values to all the tours that 
have the same timeline as the current tour. 
 
Click the​ Save to all tours of this project​ button to save the values to all tours of the project. 
 
Otherwise adjustment will need to be done once for each tour and saved with the​ Save to 
this tour​ button. You can select the tour at the top-right hand. 
 
You can see the​ Yaw, Pitch and Roll​ values of all tours at once on the Projects tab. 
 
It’s possible to undo any saved values by clicking on the ​Undo save​ button 
 
Exposure adjustment 
Default is 1.5. This makes all the images a bit brighter than the source images. 
If you want no change, set it to 0. 
 
Level 
Yes​: The most commonly used set-up. 
Level with the log value and the values from the Adjust tab. 
No​: No leveling at all. 
Adjust​: Use values from the Adjust tab only. Ignore the log data. 
 
Timezone adjustment 
Creator automatically calculates the local time from  

- the tour name, which includes the tablets time  
- the camera’s log data, which has the GPS time. 

 
In case the tablet time was not set to local time, you can adjust it here. 
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Web Player Setup 

Preferences sub-tab 
Set all the player preferences for the player.xml file. 
 
Alternatively you can change this by editing the​ player.xml​ file. 
Manual edits made to the player.xml file will not be shown here. 

Basic 

 
 
Pick 
Pick the start view from the ​Player​ tab 
 
Set manually 

 
 
Start Tour 
 
Start Panorama 
 
Start Viewing Direction left-right (degree) 
 
Start Viewing Direction up-down (degree) 
 
Start Zoom (degree) 
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Title 
The project name will be suggested by default. You can overwrite it. 
 
Left Menu text 
 
Left Menu URL 
 
Left Menu URL target 
 
Right Menu text 
 
Right Menu URL 
 
Right Menu URL target 
 
Permalink Text 
 
Timeline label 
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Logo 
Path to a logo image in PNG format to be displayed in the top right corner of the player. 
 
Logo URL 
Clicking on the logo will open the specified URL. 
 

 
 
Map 
Show/Hide Map 
 
Permalink 
Show/Hide Permalink 
 
Menu 
Show/Hide the Menu 
 
Map Button 
Show/Hide the Map button 
 
Navigation mode 
Arrows/Hotspots/Arrows and Hotspots 
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Streetview 

 
 
View 
Relative to Car/Forward 
 
Mouse Control 
Streetview style (recommended) / Old-school streetview style 
 
Minimum zoom limit (degree) 
 
Maximum zoom limit (degree) 
 
Look down limit (degree) 
 
Look up limit (degree) 
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Show Arrow label 
Mouse/None/Always 
 
Clickable Arrow labels 
 
Arrow labels from this column of the Streetview table 
Road/Streetview/Description 
 
Show Hotspot label 
Mouse/None/Always 
 
Clickable Hotspot labels 
 
Hotspot label from this column of the Streetview table 
Road/Streetview/Description 
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Map 

 
 
Map Provider 
Select any online base layer from the dropdown menu or define your own custom map tile 
set. 
 
Map View 
Start Panorama/Data Extent/Lat,Lon 
 
Map icon base-color 
Color of the default map icon 
 
Map icon selected 
Color of the selected map icon 
 
Map icon mouse-over 
Color of the map icon when the mouse cursor is on it 
 
Map marker scale (touch) 
Adjust marker scale on touchscreen devices 
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Radar-cone 

 
 
Show Radar-cone 
Show/Hide Radar-cone 
 
Radar-cone size units 
Units used to resize the Radar-cone. If percentage option is selected, the percentage refers to 
the total map height. 
 
Radar-cone size value 
Radar-cone size value 
 
Radar-cone stroke color 
Color of the Radar-cone border 
 
Radar-cone fill color 
Color of the Radar-cone 
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POI 

 
 
Create poi-list.php file in the 'player' folder 
 
Show label for a POI 
None Do not display a label for the POI 
Streetview  Use the streetview name as the label for the POI 
Road  Use the road name as the label for the POI 
 
Show POI name 
Comment only Display the POI comment only  
Yes Display the POI name and the comment 
No Do not display the POI name 
 
 
In case you need to create a more advanced POIs file, set ​Interface​ to ​Advanced​, then use 
Tools -> Export​, for example in .csv format.  
You can then construct any kind of links easily with the free ​Libre Office Calc​ or with MS 
Excel by chaining the desired values together. 
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Floors 

 
 
Show floors 
Show floors arrows and hotspots 
 
Start floor 
Default floor to start the Player with 
 
Floor label 
 
Next and previous Floors color 
 
Floor does not exist in timeline message 
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Automatic rotation 

 
Enabled 
 
Wait time 
Time in seconds before the rotation starts 
 
Speed 
Rotation speed 
 
Direction 
Automatically pan streetview either to the right or left 
 
Horizon 
Automatically pan streetview to match a specific horizon 
 
Zoom to FOV 
 
Click disables auto rotate  
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Expert 

Arrows 

 
 
Show Arrows for nearby streetviews 
 
Display nearby Arrows within this distance (meters) 
 
Maximum number of nearby Arrows 
 
Arrow image scale (mouse) 
 
Arrow image scale (touch) 
 
Next and previous Streetviews color 
 
Nearby Streetviews color 
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Hotspots 

 
 
Camera height offset from ground level (meters) 
 
Show nearby Hotspots 
 
Display nearby Hotspots within this distance (meters) 
 
Maximum number of nearby Hotspots 
 
Hotspot width (pixels) 
 
Hotspot color 
 
Hotspot opacity 
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Arrow label style 

 
 
Font 
 
Font size 
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Bold 
 
Show Background 
 
Background color 
 
Background alpha 
 
Show Border 
 
Border width 
 
Border color 
 
Round edge radius 
 
Text color 
 
Padding (Top Right Bottom Left) 
 
Text align 
 
Y offset 
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Hotspot label style 

 
 
Font 
 
Font size 
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Bold 
 
Show Background 
 
Background color 
 
Background alpha 
 
Show Border 
 
Border width 
 
Border color 
 
Round edge radius 
 
Text color 
 
Padding (Top Right Bottom Left) 
 
Text align 
 
Y offset 
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Default start zoom (degree) 
 
 
Tiles path 
The Panorama-tiles url should point to the streetviews-tiles folder uploaded to a web-server. 
There is no need to add a \ at the end of the url. 
 
Maximum map zoom 
 
Panorama map icon width 
 
Panorama map icon height 
 
Timeline error message 
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Preview sub-tab 
See a preview of what the Player and the Panorama will look like. 

 
 
After adjusting the view (Start Tour, Start Pano, Start Viewing Direction, Start Zoom) click on 
Save current view as the project's start-view​ to make the current view the start-view of the 
project. 
 
You can go back and forth between ​Preferences​ and ​Preview​ until you are happy with the 
resulting player. 
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Process Preferences 

 
 
Copyright 
This is written into the EXIF metadata of the equirectangular .jpg streetviews that have been 
created. 
 
Start​, ​Step​ and ​End​ allow for quick adjustments independent of the Map tab. 
Very useful to create a project overview quickly. 
 
Start 
Start processing with this tour and streetview. 
 
Step. Process every x-th data-set 
 
For example if the total number of streetviews is 100.000 then: 
Step 100      will process 1%     of the active streetviews only: 1000 streetviews. 
Step 1.000   will process 0.1%  of the active streetviews only: 100   streetviews.  
Step 10.000 will process 0.01% of the active streetviews only: 10     streetviews.  
 
End 
End processing with this tour and streetview. 
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Number of data sets 
Calculated based on Start, Step, End and the streetviews active on the map tab only. 
Already existing output and eventual ​Skip​ settings on the Process tab will not be considered. 
 
Create project backup before starting processing 
If ticked before processing, a backup of the project will be created in the Output path folder. 
 
Project's Input path 
Path to this project's source folder. 
 
Project's Output path 
Path to this project’s output folder. 
 
Panorama-tiles Output path 
Path to the streetview-tiles output folder. 
Allows you to save tiles directly to a USB-HDD for shipping to, for example, a datacenter.  
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Process 

Web-Player 

Creates a working web-player that you can install to a web-server. 

 
From X existing streetviews only: 
Do not create new streetviews. Create tiles from already existing streetviews only. 
 
Add local map tiles: 
If ​custom map tiles​ are set up in the map tab. 
 

Android-Player 

Generate a ZIP archive that can be opened with the Android Player App.  
It works offline, without Internet connection. 

 
Add local map tiles: 
If ​custom map tiles​ are set up in the map tab. 
 

Streetviews Only 

Generate 8192 x 4096 pixel Streetviews only. 
Use this mode for generating streeviews for either the Photogram or your own workflow. 
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Process 
When starting to process, a pop-up appear and will summarize the settings. 
Click​ Start process​ or​ Cancel​ to make adjustments. 
 
Open Project's output folder 
Click to Open the project's output folder in the Windows Explorer. 
 
Save this project preferences as default 
Save these project preferences as a default for new projects.  
Click on ​Check​ to open the ​Preferences - For new projects​ window. 
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During processing you can click the​ Stop processing​ button at any time. 
It might take a short time for the processing to stop, as processing is done in batches. 
 
See the log displayed below. 
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Player 

When the processing has finished, open the Player tab to see the fully functioning player: 

 
 
You can easily check what the player would look like using the ​Standard​, ​Legacy, Aerial​ ​Fullscreen, 
Arrows and Hotspots, Hotspots with labels, All ​layouts: 
 
Click ​Save to this Project ​to save the current Layout of your project. 
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Please note that you will then need to re-create the Web Player on the Process tab.  
Set ​Web Player​ to ​Overwrite​. 
 
Layouts: 
 
Project 
Show the project according to its settings. 
 
Legacy 
Navigation mode - Arrows 
Base Layer - OpenStreetMap.Mapnik 
Map - Visible 
Permalink - Visible 
Menu - Visible 
Show Arrow label - Mouse 
Show Hotspot label - None 
 
Standard 
Navigation mode - Hotspots 
Base Layer - OpenStreetMap.Mapnik 
Map - Visible 
Permalink - Visible 
Menu - Visible 
Show Arrow label - Mouse 
Show Hotspot label - None 
 
Aerial 
Navigation mode - Hotspots 
Base Layer - HERE.satelliteDay 
Map - Visible 
Permalink - Visible 
Menu - Visible 
Show Arrow label - Mouse 
Show Hotspot label - None 
 
Fullscreen 
Navigation mode - Hotspots 
Base Layer - OpenStreetMap.Mapnik 
Map - Hidden 
Permalink - Hidden 
Menu - Hidden 
Show Arrow label - Mouse 
Show Hotspot label - None 
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Arrows and Hotspots 
Navigation mode - Arrows and Hotspots 
Base Layer - OpenStreetMap.Mapnik 
Map - Visible 
Permalink - Visible 
Menu - Visible 
Show Arrow label - Mouse 
Show Hotspot label - None 
 
Hotspots with labels 
Navigation mode - Arrows and Hotspots 
Base Layer - OpenStreetMap.Mapnik 
Map - Visible 
Permalink - Visible 
Menu - Visible 
Show Arrow label - Mouse 
Show Hotspot label - Always 
 
All 
Navigation mode - Arrows and Hotspots 
Base Layer - HERE.satelliteDay 
Map - Visible 
Permalink - Visible 
Menu - Visible 
Show Arrow label - Mouse 
Show Hotspot label - Always 
 
Save to this Project 
Save the current Layout as the Web Player preferences for this project. 
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Pano Window 

A second monitor is recommended for this feature. 
 

 
 
Shows the streetviews. You can zoom in and out on them. 
 
Great to move streetviews manually on the Map tab. 
 
If the streetview has already been processed, it will be displayed right away.  
If not, it will be processed and displayed. 
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Advanced Features 

 

Timeline 

Record the same road or area multiple times to document change. 
 
It looks like this:  
http://players.applied-streetview.com/Timeline/ 

 
Create a few timeline labels, such as ​Before​ and ​After ​or dates like ​2015 ​or​ 2016. ​Assign 
one or many tours to each timeline label. 
 
The user will then be able to pick the labels in the player. 
Example: ​http://players.applied-streetview.com/Timeline/ 
 
After assigning all tours to timeline labels you can use the Duplicate Remover to sort out 
duplicates in each timeline. 

 
 
 
Labels table 
 
Add label​ button 
Enter the timeline label into the text box to the left of the button, then click the button. 
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Rename selected​ button 
Click on the checkbox next to the timeline that needs to be renamed, then enter the new 
timeline label into the text box to the left of the button and click the button. 
 
Delete selected​ button 
Click on the checkbox next to the timeline that needs to be deleted, then click the button. 
Note that multiple timelines can be selected at once. 
 
Tours table 
 
Apply label to selected tours​ button 
In the drop down list to the left of the button, select the timeline to which the tours will be 
assigned to, select the tours by clicking on the checkboxes next to them, then click the button 
to assign them tours to the selected timeline. 
 
To remove a tour from a timeline label select ​None​ in the drop down list. 
 

Timeline list (Map tab) 
 

 

Click a timeline label to zoom in on it. 
Click a timeline eye icon to toggle  visibility. 
In this example, the 2016 timeline has been 
hidden. 

Hiding timelines is great when used with the ​Ctrl+A​ key-combination that selects streetviews 
in all visible timelines. 
Note that this list is displayed only when at least one tour is assigned to a timeline. 
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Separate by Distance 

To convert tours recorded in ​Interval Mode​ to ​Distance Mode ​recordings.  
This greatly reduces the number of streetviews to process. 
 
Options: 
Minimum distance between streetviews: 
About the same as the distance when recording with ​Distance Mode. 
 
Process selected timelines: 
(Visible only when there are timelines) 
Process only selected timelines. 
Press ​CTRL ​and then click on a timeline to select multiple timelines. 
 
Process selected tours: 
Process only tours selected from the list.  
Press ​CTRL ​and then click on a tour to select multiple tours. 
 
Start process 
Start processing 
 
Reset all streetviews 
Reset all streetviews deactivated by ​Duplicate Remover​ and ​Separate by Distance 
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Individual Optimizing 

Adjust for camera and leveling sensor setup individually for specific streetviews. 

 
 
The adjustment is the same as in the ​Leveling tab​, so read the section about the  ​Leveling tab 
first. 
 
Previous 
Go to the previous streetview. Does ​not ​save anything. 
 
Save 
Save ​the individual adjustment options (Exposure Adjustment, Yaw, Pitch, Roll) to the current 
streetview. Load the next streetview and apply the same values. 
 
Next 
Go to the next streetview. Does ​not ​save anything. 
 
After saving, apply the same values to the next streetview. 
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Delete 
Delete the individual adjustment options (Exposure Adjustment, Yaw, Pitch, Roll) for the 
current streetview. 
 
On the ​Processing Preferences​ tab, check that ​Leveling​ is set to ​Individual Optimizing 
(when available)​.  
 

 
 
Then start processing. 
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Map-tiles  

There are many ways to get map-tiles suitable for the Creator App. 
As an example for the format we provide the “Langen2” map tiles as a .zip file for you: 
http://updates.applied-streetview.com/Remote-Control/Langen-OSM.zip​ (1.1 MB) 
 
Map tiles format info: 
http://wiki.openstreetmap.org/wiki/Slippy_map_tilenames 

Download using JTileDownloader 
For small areas you could just download the map-tiles. 
One of the programs suitable for downloading map tiles is 
JTileDownloader 
http://wiki.openstreetmap.org/wiki/JTileDownloader 
Use it with a Windows PC, not the tablet! 
It is recommended to remove the microSD card from the tablet, then connect it to the PC 
using a USB 3.0 card reader and the included microSD to SD-card adapter. 
 

Version 2018-05-02 Page 76 of 93 

 

http://updates.applied-streetview.com/Remote-Control/Langen-OSM.zip
http://wiki.openstreetmap.org/wiki/Slippy_map_tilenames
http://wiki.openstreetmap.org/wiki/JTileDownloader


 

Go to ​Main​ - ​Bounding Box (Lat/Lon)​ and click on ​Slippy Map chooser​. This will open a 
new window and you will be able to choose the area for download. 
Choose the ​Tile Provider​. Consider OpenCycleMap, since the other tile providers tend not to 
work. 
Consider saving it directly to the microSD card. 
At least one zoom level is needed, zoom level 17 works well for recording by car. 
Choose the ​Output folder​ to download the map tiles, preferably a new folder, named e.g. 
"Town-name". 
 
Afterwards, insert the microSD card back into the tablet then use the map tiles directly from 
the microSD card.  
Do not copy the map-tiles to the tablet. 
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Tools 

Geotag sources 

Geotag source images. 
In case you want to process the source images with a totally different software. 

 
 
Original sources (faster) 
Modify EXIF data of the original images 
 
Make a copy (slower) 
Copy images to ​Output folder​ and then modify EXIF data of the original images 
 
Output folder 
Set the output folder. 
 
Click the ​Start process​ button. 
 
The current project source images will be copied to output folder.  
The following EXIF data will be added: 

- Orientation 
- DateTimeOriginal 
- GPS:GPSDateStamp 
- GPS:GPSTimeStamp 
- GPS:GPSLatitude 
- GPS:GPSLatitudeRef 
- GPS:GPSLongitude 
- GPS:GPSLongitudeRef 
- GPS:GPSAltitude 
- GPS:GPSAltitudeRef 
- GPS:GPSImgDirection 
- GPS:GPSImgDirectionRef 
- Orientation 
- FocalLength 
- FNumber 
- Make 
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- Model 
- SerialNumber 
- FocalPlaneXResolution 
- FocalPlaneYResolution 
- FocalPlaneResolutionUnit 
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Export 
Export the Creator data to use with a 3rd-party program. 
 

 
 
Output folder 
Where to save the exported data to. 
 
Panorama status 
Choose the status of exported streetviews: Activated (Default), Deactivated, All. 
 
Format 
Choose export format: CSV, GeoJSON, KML, Shape File 
 
Click ​Export​ button to export the data. 
 
Click ​Open Export folder​ to open the ​Output Folder​ in Explorer. 
 
 
WARNING: 
These formats are NOT suited for re-import into Creator. 
Instead, close the project and use the ​Backup​ on the Project tab. 
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Fix a Tours .csv files 
Tour log-data is saved to the panoramas.csv and tracks.csv files in folder 7.  
In case these files are corrupt, Creator will refuse to add the project. 
 
Instead this pop-up will be displayed: 

 
 
Simply add the Project again, but this time ​deselect the corrupt tour​. 
 
This allows you to continue your work with the remaining tours of the project. 
The missing tour can be added to the project after it has been fixed. 
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Manually fixing the corrupted .csv file(s) is the next step, then you can add the skipped tour. 
 
We recommend the free ​Libre Office​ Calc program for this. 
 
First make a backup copy of the file you are going to edit. 
 
When opening the .csv file with Libre Office Calc make sure to select all columns and set 
them to ​Text​. This ensures no automatic formatting changes the values. 
 

 
 
 
Afterwards scroll through the data, find the problem line and edit it to look like all other lines. 
 
For panoramas.csv the numbers in #0:imgID must be in sequence. 
Duplicate entries in #0:imgID are not allowed. 
Empty lines are not allowed. 
 
Save the file and add the tour to your project: 
Open the project in Creator. 
On the ​Project page​ press the ​Add tours to project​ button to add the fixed tour. 
 
 

Install the player to a web-server 
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There are 3 components: 
The player, the MySQL database and the streetview tiles folder. 
For production, you should install the player and the MySQL database to the same server, 
and the streetview tiles to a different server, or a cloud. 
For testing you can install all three to the same server. 
 
MySQL database 

Create a new MySQL database. 

Import the ​projectname/player/demo.sql.zip​ file to it. 

 

Panorama Tiles 

Copy the ​projectname/streetview-tiles​ folder to the web-server or a cloud. 

 

Player 
Adjust the 

projectname\player\plugins\streetview\ajax\db.php 

file for the database access. 

 

Adjust the 

projectname/player/player.xml 
file for the streetview tiles. 

Edit the ​tilespath ​variable to point to the streetview-tiles folders URL. 

 

Example: 

tilespath="http://www.yourcompany.com/projectname/streetview-tiles" 

Copy the ​projectname/player​ folder to the Apache web-server. 

 

More Info on the Player: 

http://updates.applied-streetview.com/player/Player_Quick_Installation_Manual.pdf 

Embed the player into any page 
It looks like on our website: 
http://www.applied-streetview.com 
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First install the player as usual. 
 
For this example, the player is installed to the folder 
http://www.your-server.com/players/Demo/ 
 
In your page, add this code: 
 
<div id="demo"></div> 
<script src="http://www.your-server.com/players/Demo/player.js"></script> 
<div id="player" style="width: 100%; height: 700px;"> 
<script> 
var settings = {}; 
settings.files_path = "http://www.your-server.com/players/Demo/"; 
settings.auth_enabled = +"0"; 
settings.permalink_anchor = "demo"; 
embedpano({swf: settings.files_path + "player.swf", xml: settings.files_path + "player.xml", target:"player", 
html5:"prefer", vars: settings, passQueryParameters:true}); 
</script> 
</div> 
 

Adjust the URL. 
You will need to remove the line breaks from the code above for it to work. 
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Remove the 'krpano demo version' logo 
What it looks like: 

 
The​ krpano demo version​ watermark is visible in the: 
 
- Web Player Preview sub-tab 
- Player  tab 
- All generated Players 
 
Get a krpano license for 129 Euro from ​http://www.krpano.com/buy  
 
Then go to ​Menu  - krpano - Add activation key​. Paste your key into the field  and click 
Add​. If the key is valid you should see a confirmation message that the key is registered. 
Restart Creator​. 
In ​Menu  - krpano - License details​ you can check your krpano activation key details: 

 
Obviously you will see your own license information, the above is just an example. 
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Help 

Help - About this PC 

 
 
Click on ​Menu - Help - About this PC​ to display helpful information like Windows version, 
Computer Name, Processor, Memory, Free disk space, Graphics Card, CUDA versions, etc. 
 
Click on ​Copy to clipboard​ to copy the information about this PC to the clipboard, then save 
it elsewhere.. 
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Preferences 
Menu - Preferences 
- For all projects 

Graphics Card 
Folders 
Map 
Expert Mode 
Troubleshooting 

 
- For new projects 

Map 
Duplicate Remover 
Watermark 
Leveling 
Player 
Imaging 
Process 

 
New projects get their default values from the ​For new projects​ preferences. 
You can then make project-specific changes in the project tabs. 
 
Reset all preferences 
Reset all preferences for new and all projects to their defaults. 
 
Menu - Preferences - For all projects - Graphics Card 
 
Graphics Card found 
Graphics cards found in the system. 
 
Applied Streetview Processor 
For fastest processing.  
 
A NVIDIA graphics card is needed. We recommend: NVIDIA GTX 1080 with 8GB VRAM. 
Legacy graphic cards with 4GB VRAM that are known to work: NVIDIA GTX 960, 960M, 
965M, 970, 980.  
 
AS-stitcher for stitching - Batch size 
How many data-sets to pass to AS-stitcher for processing at one time. 
 
AS-tiler for tiles creation - Batch size 
How many data-sets to pass to AS-stitcher for processing at one time. 
 
Legacy solution 
Works with and without a graphics card, many graphics cards should be supported. 
The Legacy solution for streetview-tiles creation needs a krpano licence. 
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Enable graphics card 
Speed up the processing by enabling the use of a graphics card, many graphics cards should 
be supported.  
 
Parallel processes 
How many datasets to process in parallel. Should be set automatically to the number of CPU 
threads - 1. Check and adjust if necessary. 
 
Menu - Preferences - For all projects - Folders 
 
Input path 
At this location the Creator looks for the project source folder, when creating a new project. 
You can switch it to any other location. 
 
Output path 
At this location the Creator automatically creates a project folder with the same name as the 
project. 
Then the sub-folders for the data are created: streetviews, streetview-tiles, player, map-tiles. 
 
PTO path 
All of the cameras​ .pto​ files should be copied to this location. 
 
Temp path 
For temporary files. To improve speed in legacy mode the path should be on a SSD or 
RAM-disk. 
 
Menu - Preferences - For all projects - Map 
 
Zoom level to load all data-points 
At this level all the data-sets are displayed on the map. 
 
Contents of pop-up 
Left list contains all the available fields, the list to the right contains the list of fields that are 
displayed in the popup. 
 
To add a value from the left list to the right list, click on an item in the left list then click ​> 
button. To remove a value from the left list, click on an item in the right list then click ​<​ button. 
Click on ​>>​ button to move all the items from the left list to the right list.  
Click on ​<<​ button to move all the items from the right list to the left list.  
Click the ​Up​ or ​Down​ buttons to change the order of items displayed in the pop-up. 
 
Menu - Preferences - For all projects - Expert Mode 
Only use these options when the Applied Streetview support asks you to. 
 
Do not delete temporary files 
 
Skip vig_optimize program and exposure adjustment 
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In legacy mode skip the vig_optimize and exposure adjustment steps. 
 
Log command lines of external programs 
 
Log terminal output of external programs 
 
Log process time information 
In legacy mode log information about each processing step. 
 
AS-stitcher CUDA 8 options 
Additional command line arguments to pass to as-stitcher8.exe 
 
AS-tiler options 
Additional command line arguments to pass to as-tiler.exe 
 
Menu - Preferences - For all projects - Troubleshooting 
 
Fix ​Camera accidentally mounted looking backwards. Click again to undo. 
 

 
Show Tracks in the Map tab. Enabling this feature may slow down or crash Creator. 
 

 
When moving streetviews on the map, do not move Tracks data. This will stop the Duplicate 
Remover from working properly later on. 
After this feature is enabled, in the Map tab the tours list will have an additional column 
“tracks” to control track visibility. It is recommended to enable this feature on a larger zoom 
level, 16 and up. 
 

 
Check and deactivate all data-sets with missing .jpg files when processing. 
Click on ​Check ALL data-sets now​ to check now. 
If images are missing for any reason,this will deactivate the affected data-sets to nsure the 
remaining data processes well. 

 
Check and rotate all the data-sets with incorrect rotation when processing. 
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Click on ​Check ALL data-sets now​ to check now. 
Sometimes users have a look at the source images and rotate them upright for a better view. 
Unfortunately some programs save these rotated source images without warning. This feature 
rotates the source images back to ensure that the data processes well. 
 

 
Use a specific PTO file 
By default, the .pto files name is taken from streetviews.csv 1:CamSN field.  
This option allows you to override this functionality and always use a specific .pto file.  
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Menu - Preferences - For new projects - Map 
 
Duplicate Remover overruled by 

- Manual activations - streetviews activated manually will override values set by 
duplicate remover. 

- Manual deactivations - streetviews deactivated manually will override values set by 
duplicate remover. 

 
Default Base Layer 
 
Menu - Preferences - For new projects - Duplicate Remover 
Default preferences for the ​Duplicate Remover​ tab. 
 
Menu - Preferences - For new projects - Watermark 
Default preferences for the ​Watermark​ tab. 
 
Menu - Preferences - For new projects - Leveling 
Default start streetview 
 
Exposure adjustment 
Default is 1.5. This makes all the images a bit brighter than the source images. 
If you want no change, set it to 0. 
 
Level 
Yes​: The most commonly used set-up. 
Level with the log value and the values from the Adjust tab. 
No​: No leveling at all. 
Adjust​: Use values from the Adjust tab only. Ignore the log data. 
 
Menu - Preferences - For new projects - Player 
Default preferences for the ​Player Preferences​ tab. 
 
Menu - Preferences - For new projects - Process 
Default preferences for the ​Process Preferences​ tab. 
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Support 
 
Please check for a new Creator version first: 
Menu -> Help -> Check for Update. 
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Support is provided for the newest Creator version only. 
 
 
Support is available in ​English language​ only. 
 
To report an error, please use this form: 
Menu → Help → Support 
You can ​enter text​ and ​attach files​. 
The log-file is automatically attached. 
You can attach extra screenshots. 
 
Contact 
Helpdesk: support.applied-streetview.com 
E-Mail: support@applied-streetview.com 
Skype ID: applied-streetview 
Phone: +49 6103 - 372 7494 
 
Streetview Technology GmbH 
Pittlerstr. 53 
63225 Langen 
Germany 
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